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Introduction



What's an accessible document?

= An accessible document is one that every person
can read, understand, and interact with in a
comparable experience.

- For example: in a similar amount of time or
level of expertise with the program.




Before we get started, understand:

= This presentation focuses on making a workbook
accessible to people with low-vision or blindness.

= |n Excel, there are numerous ways to achieve each
task. Multiple approaches are valid.

= WCAG standards can be mapped to Excel
workbooks.




People with low-vision:

= May have challenges discerning text or elements,
such as within charts/graphs, which have low
color contrast.

= May magnify the workbook, which necessitates
more scrolling and seeing less content at once.




People with blindness:

= Primarily navigate using the cursor keys to move
one cell in one direction at a time.

= Excel's robust functionalities can be accessed
using the popular screen readers, but people may
not know the full range of keyboard commands.




Structure



Give each worksheet a unique,
descriptive name

= Sheet name should provide information about
what is found in the worksheet.

Don’t use: 1@ Accessible Example: 1&

Default sheet names Concise and descriptive names

| 2019 Overview | North America Sales | UK Sales I

Sheet1 | Sheet2 | Sheet3 | (¥

Not human readable text

I
I
I
I
I
I
I
I
I
I
I
I
al-102923902g3-77 ® |
I
1
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Do not leave Cell A1 blank

= Cell A1 is a critical landmark for structure and
navigation. Start content at A1.

= When a screen reader user enters a worksheet, the first
selected cell is AT.

= Cell A1 should be used to orient users to the structure
of the workbook or worksheet.

= Examples to follow:



Example 1:

When the sheet contains a single table,
use A1 to provide a title for the table.

Al - Jr | 2021 Options Activity

A B | C | D | E | F | G

1| {2021 Options Activity|

2

3 |ROKU Call 19-Feb 4% 27.15 $  34.95 $3,120.00
4 \WMT Call 19-Feb 5% 355 $  4.65 $550.00
5 |RKT Put 5-Mar 30 $ 214 S 1.85 -$870.00)
6 |BYND .‘Put 21-May 18 19.40 $  24.50 $510.00

Avoid blank rows between the title in A1 and the table. (more on
this later)




Example 2:

When the workbook/worksheet has a more
complex structure, provide a text summary.

= To aid screen reader users, the text summary should
describe the workbook or worksheet's structure.

= When a sheets has multiple tables or sections, the

summary should state the cell where each element
starts.

= The summary should note if the worksheet contains
charts/graphs, images, anything interactive, or irregular.




Provide a text summary example

A B . C . D . E . F . G . H [ |
The worksheet contains a table :
displaying client performance and a line Holdings Value
chart_ dlsplaylng the value of total $30,000.00
holdings over time. Investment
| disclaimer (Cell A11) $25,000.00
$20,000.00
3 |Historical Client Performance
$15,000.00
4 ﬂ Holdings Value i
5 1/1/2016 $ 18,128.00 $10,000.00
6 1/1/2017 S 20,320.00 $5,000.00
7 1/1/2018 $ 23,221.00
8 1/1/2019 $ 23,994.00 >
9 1}.1’.2025 S 7 045.00 1/1/2016  1/1/2017  1/1/2018  1/1/2019  1/1/2020
10

All investments involve the risk of potential
investment losses. Prior performance is no
guarantee of future results, and there can be
no assurance future performance will be
comparable to past performance. No client
should assume any information presented is
personalized financial planning or investment
advice.

The text summary can be made only for screen readers. Set

the font color to white, in effect making the text visually
hidden.




Simplify your workbook

= When a worksheet has multiple sections or tables,

separate each element by a single row. Avoid multiple
blanks rows/columns.

= When multiple rows separate elements, screen reader
users may reach the end of a table/section and not

know there is more content further down the
worksheet.




Hide unused rows, columns outside
the working area

= This prevents users from wandering into parts of the worksheet
that are not being used.

= |t reduces the workbook’s file size, making the file more
performative.

= Do not hide rows/columns within the working area.

= Do not merge cells. This disrupts screen reader users’ navigation

and understanding of where they are located within the
spreadsheet.



Hide unused
rows/columns

Step 1: Select a row or
column outside working
area.

Step 2: Press Ctrl + Shift +
Right (=) to select all columns
to the sheet’s end OR

Ctrl + Shift + Down () to

select all rows to the sheet’s end.

Step 3: In the Home tab in
the Ribbon, select Format >
Hide & Unhide > Hide
Rows/Hide Columns

File Home Insert Page Layout Formulas Data Review View Help % Share {1 Comments

E"‘ X Calibri vilov | = EE g(l} General + | [E conditional Formatting ~ EHinsert ~ >~ é?v [

. D[Ev B I U. A | === - $ v % 9 @FormatasTable“ BX Delete ~ &~ ,Ov AIII

aste - - - - = = nalyze

LS HY oA | EE . RS [ el styles ~ O~ Data

Clipboard T8 Font = Alignment I Number = Styles Cell Size Analysis Sensitivity ~

F1 M fe I] Row Height... ~
AutoFit Row Height
A B C D H [F G H | M ) N o P Q a
i Symbol - Amount - Average Cost- Sale Price i o Width..
2 |ROKU 45 27.15 S 34.95 § X
5 [wmT 55 355 5 265 AutoFit Column Width
4 [RKT 30 § 214§ 1.85 )
5 [BYND 15 19.40 § 24,50 Default Width...
L |

& |OPEN 15 510 $ 5.20 o
7 Visibility
8
: Hide & Unhide > Hide Rows F
10 . o
a0 Organize Sheets Hide Columns —
E @ Rename Sheet Hide Sheet —
1: Move or Copy Sheet... Unhide Rows 1
?Ig Tab Color > Unhide Columns |
= Protection [
1)
20 EE Protect Sheet...
21
22 Lock Cell
23
24 Format Cells...
25 T T T T
26 | | | h
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Tables



Identify tables and define row/column

headers

Correctly marking up a table dramatically improves navigation for screen
reader users. Without table structure, it is easy for screen reader users
to quickly get disoriented.

A table MUST have a single row header, a single column header, or both.

There are two approaches to identify tables. For both, the semantic
information is saved with the file.

- (1) Create Table

- (2) Use Name Manager



Create Ta ble Scrgenshot shows the table selected

Step 1 G14 - X v k||
A B C D £ P G
1 |Annual Budget
Select the table 2 Rent Utilities Food Gas Auto Insurance Medical
: : : 3 [January 2250 162 560 51 80 240
mCIUdmg its row and 4 |February 2250 158 630 41 80 240
column headers. 5 |March 2250 130 680 42 75 180
6 |April 2250 171 634 25 75 240
Selection should not include the 7 |May 2250 174 613 90 75 120
table’s title - if there is a title. 8 [June 2250 181 725 44 75 1640
9 |July 2250 161 692 55 125 210
10 |August 2450 155 730 25 75 640
11 |Septembe 2450 131 704 60 80 180
12 |October 2450
13 [November
14 |December
15
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Create a table

Once the table area is
selected, to identify it as a

table, either:

Go to the Insert tab in the
Ribbon and Select Table

OR
Press Ctrl+ T

Screenshot of Create Table dialog

Tab ?

| Creat

(i
D
D

| Where is the data for your table?
 $A$2:3G$14

v ME table has headers

oK Cancel

|=»

= Check the box “My table has headers”
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Screenshot Table Style Options within the Table
Design tab in the Ribbon

v Help Table Design
Define whether the v| Header Row |v| First Column  [v/ Filter Button
table has row headers, Total Row Last Column
column headers, or v| Banded Rows | | Banded Columns
both. Table Style Options

= When a cell within the table is selected, the Design
or Table Design tab (exact name depends on the
Excel version) is shown in the Ribbon.

= "Header Row" identifies the first row as a set of
row header titles.

=  "“First Column” identifies the first column as a set

of column header titles.
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Screenshot of the Table Design tab in the Ribbon with Table Name
highlighted. “AnnualBudget” is chosen as the Table Name.

File Home Insert Page Layout Formulas Data Review View Help Table Design
Table Name: Summarize with PivotTable [==l | D [] v| Header Row |v| First Column | Filter Button
Bud E Ri Duplicat E? j:'L’ [_:‘ Total Row Last Column
AnnualBudget » Remove Duplicates Insert e [
2} Resize Table |[JG3 Convert to Range Slicer v v v| Banded Rows Banded Columns
Provide a name for the el e ot e e oprs

table.

= Use a table name which describes the table's
contents. Do not use default “Table1”,
“Table?”, etc.

= Table Name cannot have spaces. Instead,
capitalize the start of each word aka use
camelCase, so screen readers will correctly
pronounce the name.
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= When a table is identified and its
row/column header titles are defined:

- Screen readers (JAWS 2021 and

TU ' on a Windows' built-in screen reader
Narrator) announce each cell's value

screen AND its associated row/column

headers.

reader and
test!

- Upon entering the table, screen
readers announce the name of the
table and the number of rows,
columns.
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Common issue: Multi-tiered column
headers

A table may onIK define a single row of column headers or single column of row

headers, or bot

headers.

In the screenshot below, three tiers of column headers:

There is no method to associate a cell with multi-tiered

(1) Levels/Changes from preceding quarter, (2) Year, (3) Quarter

A B C D E F . G H . | |
1 | Release Date: September 30, 2021
2 | Paycheck Protection Program Subsidies by Industry in the National Accounts, 202102
3 | (Billions of dollars, annual rates)
4
5 | Levels Change from preceding quarter
6_ Line 2020 2021 2020 2021
7 Q3 Q4 o)} Q2 Q4 Ql Q2
8 1| Total Paycheck Protection Program Subsidies to Private Industries ! 819.5 246.3 184.6 427.2 -573.2 -61.7 242.6
9 | 2 Agriculture, forestry, fishing, and hunting 13.7 4.1 6.4 14.8 -9.6 2.3 8.4
10 3 Mining 7.9 2.4 2.3 5.4 -5.5 0 3.1
11 4 Utilities 2.4 0.7 0.3 0.6 -1.7 -0.5
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Solutions to multi-tiered headers

= Option 1:
- Break up the complex table into smaller tables
= Option 2:

- Apply screen reader-only (visually hidden) text within each
header title to provide an extended and more descriptive title.

- For example: “Q2" — “Levels 2021 Q2"
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Identifying tables benefits all users

Excel adds sort/filter functionality.

For the annual budget table, used in previous slides, let's add a
column to sum up each month'’s expenses.

Table markup improves the formula’'s readability. Compare:

Not identified as a table: '

X v Kk

=A3+B3+C3+D3+E3+F3+G3+H3

Table and row header titles correctly identified: 1ée

Jx

=[@Rent]+[@Utilities]+]| @ Food]+[@Gas]+[@[Auto Insurance]]+[@Medical]
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Use Name
Manager

Excel has a built-in syntax to give
names to a range of cells and build
row/column titles into the workbook.

Every region within the spreadsheet
should have a name. Names must be
unique.

Create Table is more straightforward
but Name Manager can be used more
broadly.



Screenshot shows Name Manager in the

Deﬁ ne Na mes Quick Search suggestions
Step 1 R

Best Action

Name Manager

Open Name Manager

ll

Acti

From the Quick Search Toolbar, cHons

type “Name Manager” & Name aRange N
n:

Find in Document

@ “name”

Get Help on
"name”

@ >
10 results

/O More search results for "name”
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Select “New" which
opens a dialog to select
the cell range.

Screenshot of Name Manager dialog with new button

highlighted
Name Manager X
New. Edit... Delete Filter =
Nam Value Refers To cope Comment
Refers t
x )
Close
A
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Screenshot of example table

A B | C |
1 |Students _|Sr:ore Grade
2 |Sheryl Ng 1220 11
Use naming syntax to 3 |Thomas Wong 1340 11
define cell ranges for 4 |Zachary Barry 1190 10
the row and column =

header titles.

= TitleRegionStudents..C4 - Define row
Names must be and column headers

unique. . .

= RowTitleStudents..C4 - Define only row

Syntax is two periods headers
with no space,

followed by the . : _ .
bottom rig%/‘lt ColumnTitleStudents..C4 - Define only

coordinates. column headers
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Use of Color



Provide sufficient text color contrast

= Ensure that foreground worksheet text has sufficient color
contrast with its background.

= WCAG requires a minimum of:

- 4.5:1 color contrast ratio for “regular” text (smaller than 18pt
font, or bold and smaller than 14pt font).

- 3:1 color contrast ratio for large text (at least 18pt font, or bold
and at least 14pt font).
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Do not use color alone to convey
meaning

= Screen readers do not announce that a cell has a different
background color or foreground text color.

= When a table uses color and conditional formatting, use the text
summary in A1 to state which cells have additional meaning,.

= Alternatively, place screen reader-only text within the cell to
indicate the meaning conveyed by the color.
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Example of a table using color alone

A

[

|"“|J’*'|""'|M

Ly

-\..4

D

NPS Scores

Client

Acme Industries - -Detracturs

Blue Star Airlines

Duff Beer

Testing Company

Passives
Promoters

Screen reader and also
low vision users are
unable to determine which
fields are detractors,
passives, or promoters.
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Example using text instead to convey

the same meaning as color

A B

Scores 0-6 represent
Detractors, scores 7-8
represent Passives, and
Scores 9-10 represent
promoters.

NPS Scores

Client ~* Score

Acme Industries
Blue Star Airlines
Duff Beer

Testing Company

~ W0 ~ w4

= Cell A1 functions as a legend
indicating the meaning of the
different colors. This
information previously had
only been visually
communicated.
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Graphs /
Charts



Excel has a cell layer and a floating
layer

= When a worksheet has charts, graphs, or images, these objects are
in the floating layer. They are not a part of an individual cell.

= Screen reader users may not be aware of the content. Screen
readers are not notified that there is content in the floating layer. A

screen reader user must actively move to the floating layer to find
the content.

= Navigating to the floating layer is cumbersome.
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Provide alternative text for the
chart/graph

= Do not display charts/graphs alone. Always provide the object’s
meaning in an equivalent format i.e. accessible data table.

= Alternative text can be applied to floating objects but screen
readers may not encounter the alternative text.

= |n addition, provide alternative text in the cell layer. Cell A1 is a
logical outlet.
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Use of color in charts / graphs

= Charts and graphs present challenges to people that are low-vision
or have some level of color blindness. Charts often rely on people
perceiving color.

= Provide data labels that are always visually present.

= Use patterns, e.g. dotted lines or striped bars, to visually identify
different chart elements. Color is not required to understand this
meaning.
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Accessibility
Checker /
Document
Inspector



Accessibility Checker and Document

Inspector

Protect Workbook
Control what s of chan

= Accessibility Checker and the
Document Inspector can be
accessed numerous ways.
Screenshot shows both tools in
Excel's Backstage View, in the
Info Tab.

= Accessibility Checker can run on-
demand or continuously while
one authors the workbook.
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Accessibility Checker is helpful but

understand its limitations.

Automated testing is good at detecting occurrences of simple issues

but has significant gaps in testing coverage; manual testing is always
required.

- Examples to follow:
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More on Accessibility Checker

The checker flags default sheet names but does not cite non-
descriptive or non-readable sheet names as errors or warnings.

Flags lack of alternative text, but cannot evaluate the quality of the
alternative text.

Flags hard-to-read cell text with low color contrast but does not test
charts/graphs, images

Lack of content in cell A1 is not identified as an error or a warning.

Tables and row/column headers not being defined is not identified as
an error or warning.



Document Settings

= |n Document Properties, reachable from Excel's Backstage view,
provide a title, subject, author, and language. Authors may also
add keywords/tags if they so choose.

= Document Inspector helps authors prepare a workbook for
distribution. Inspector makes authors aware of any comments,
revision data, notes and can strip them out this information which
IS not intended for end users.
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Conclusion



Does WCAG = WCAG does not directly apply to Excel.

aPP'Y? = However, if your website/application hosts
Excel workbooks, then WCAG arguably
applies. Ultimately, site authors are
responsible for all content in their website
or application.

= Even if the spreadsheet is not publicly
available, internal employees require
accessible documents. The inability to work
with an internal document represents an
accessibility issue.
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Should you
use Excel?

HTML is most accessible.

For websites, allowing users to download
workbook to access a simple table, HTML is
a more lightweight way of providing the
tabular information.

Excel fundamentally makes an assumption
about the programs, tools available to the
user. Not every person has Excel.

Excel does not work as well with assistive
technologies when used on Mac.
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Excel has many exciting new features

= Data From Picture
- Does not produce accessible output by default
= Analyze Data

- Requires that tables are simple and correctly
structured. Has trouble with more complex
tables.
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Document Remediation and Trainings
Available

= Word Accessibility = Accessible Source
Document
Fundamentals

= PDF Accessibility

= Advanced PDF
Accessibility

= PowerPoint
Accessibility

= Excel Accessibility

= InDesign Accessibility

TPGi)



Thanks for all the help!

- Freedom Scientific @FreedomSci

- Microsoft Accessibility @MSFTEnable

- Zhi Huang, Access Ingenuity



https://twitter.com/FreedomSci
https://twitter.com/MSFTenable

Questions?
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